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D. Pengantar  

 Dalam melakukan penelitian, kita perlu menguasai berbagai komponen metodologis, 

antara lain desain penelitian, skala pengukuran, penentuan subyek, perhitungan besar sample,  

pengolahan data dan pemilihan uji hipetesis yang tepat. Panduan ini dibuat khususnya untuk 

pengolahan data dengan program  computer. Ada beberapa program yang dapat digunakan 

sebagai alat pengolahan data (statistic), bahkan di dalam MS Excel yang lengkap pun ada 

fasilitas untuk pengolahan data. Pada praktikum IT blok ini, yang akan dipelajari dan 

dipraktekkan adalah SPSS.  Berikut ini dibahas cara penggunaan SPSS secara umum, meskipun 

kenyataannya ada banyak versi, namun pada dasarnya cara penggunaannya adalah hampir 

sama. Hal penting dalam menggunakan SPSS adalah bahwa pengguna harus mempunyai bekal 

penguasaan statistic yang memadai. SPSS hanyalah alat untuk mengolah data. Selebihnya 

pengguna harus dapat menginterpretasikan hasil pengolahan data dengan tepat, agar dapat 

menarik kesimpulan yang tepat pula.  

 

E. MATERI I 

F. BEKERJA DENGAN SPSS 

 

Memulai SPSS 

Aktifkan program SPSS  di computer dengan meng-klik icon program tersebut. 

Pada saat pertama kali membuka SPSS, selalu nampak tampilan pertama sebagai berikut : 

 

 
Gambar 1      Menu Utama SPSS 

 

Windows (tampilan) di atas disebut SPSS DATA EDITOR yang selalu muncul setiap kali 

SPSS dibuka dan merupakan windows utama pada SPSS. Perhatikan kalimat “SPSS Data 

Editor” yang menunjukkan anda sedang berada pada area tersebut; hal ini untuk 

membedakan dengan output SPSS yng disebut VIEWER. 

 

A. Mengenal menu-menu pada data editor 



1. Menu File :  

       Merupakan menu pertama dari DATA EDITOR yang dibuka, dan berfungsi mengatur 

operasional file-file SPSS sepeti membuat sebuah file baru (NEW), membuka file yang 

sudah ada (OPEN), mencetak file tertentu (PRINT), seperti pada windows MS Office. 

 

2. Menu Edit  

    Digunakan untuk melakukan perbaikan atau perubahan berkenaan dengan data yang 

telah dibuat ataupun berbagai option lainnya. Berbagai perubahan tersebut meliputi 

menghapus data/kasus, menganti isi data, mancari data, dll. Pada dasranya langkah-

langkah penggunaan pada menu ini serupa dengan penggunaan pada program MS Office 

yang telah kita pelajari di awal praktikum IT. 

 

3. Menu View 

       Pada dasarnya berfungsi meyajikan penampilan data, toolbars dan output SPSS pada 

layer monitor; pengerjaan pada menu ini tidak mengubah isi variable atau data, juga tidak 

berpengaruh pada perhitungan statistic yang dilakukan 

4.  Menu Data  

      Berfungsi membuat perubahan data SPSS secara keseluruhan 

5.  Menu Transform 

        Berfungsi membuat perubahan data pada variable yang telah dipilih 

6.  Menu Analyze  

      Menu Ini merupakan jantung dari program SPSS karena pada menu inilah seluruh 

perhitungan statistic dilakukan. 

7.  Menu Graphs 

          Menu ini berfungsi menampilkan grafik/chart yang merupakan hasil perhitungan 

statistic data yang ada pad DATA EDITOR. Menu ini cukup penting dan kompleks yang 

berguna dalam penyajian data serta laporan yang berupa grafik. 

8.  Menu Utilities 

          Berfungsi sebagai tambahan pengerjaan data ststistik dengan SPSS  

9.  Add-ons 

          Berisi berbagai macam prosedur statistic lanjutan yang bias dilakukan oleh SPSS, 

seperti CONJOINT, CATEGORIES, ADVANCED MODEL, dll. 

10. Help 

          Berfungsi untuk menyediakan bantuan informasi program SPSS 

 

B. Membuat file data 

Dimulai dengan membuka view DATA EDITOR. Pada area DATA VIEW terdapat 2 

bagian utama, yaitu : 

1. kolom : terdapat kata var dalam setiap sel kolomnya. Kolom ini adalah tempat untuk 

menuliskan macam variable yang akan dianalisis (seperti : tinggi badan, berat badan, 

dll)   

2. baris : dicirikan dengan adanya angka 1, 2, 3 dst. Baris ini adalah tempat mengisikan 

data/kasus (seperti : nama responden, angka berat badan, angka tinggi badan,dll) 

 

Setelah mambuka Data Editor, anda akan mulai dengan lembar kerja baru. Hal penting 

yang harus dikuasai sebelum memasukkan data adalah mendefinisikan variable 

Misalnya jika kolom 1 akan dibuat nama responden, maka pertama kali, klik mouse 

pada sheet tab VARIABLE VIEW, atau dengan mengklik menu VIEW lalu submenu 

VARIABLE. Oleh karena ini variable pertama, tempatkan pointer pada baris 1. Ada 



beberapa point penting yang harus dibuat untuk mendefinisikan suatu variable pada 

variable view, yaitu : 

Name     : dobel klik di bawah kolom Name, ketik nama, lalu tekan tombol  enter 

Type : definisikan variable  jika tidak diubah, maka secara default SPSS memberi 

tipe numeric. Untuk variable nama termasuk gabungan huruf (non angka) 

maka klik kotak kecil di kanan sel tersebut, pilih String, tekan ok 

 Ada kalanya, kita memasukkan data yang sebenarnya bukan data numeric 

(misalnya data tipe string), namun ingin kita analisis dengan SPSS. Untuk 

itu data tersebut dapat dinumerikkan dengan kode/kategorisasi, yaitu 

dengan memilih tipe data numeric pada saat mendefinisikan variable pada 

variable view . 

Width : menentukan banyaknya karakter yang bisa dimasukkan ke dalam kolom 

tersebut. Pada kolom ini disediakan 1 s/d 255 karakter yang bisa (untuk 

data string, dan 40 untuk data numeric) dimuat. Anda bisa menentukan 

besar/lebar kolom sesuai kebutuhan, dengan langsung mengetik 

   Atau menggunakan scroll number, untuk angka naik atau turun 

Decimals : fasilitas ini hanya aktif jika tipe variable berupa angka. Fasilitas ini 

menentukan berapa angka di belakang koma, data yang akan dimasukkan. 

Jika variable bertipe string, maka otomatis tidak ada decimal, sehingga 

fasilitas ini tidak aktif (warna buram) 

Label : adalah keterangan untuk nama variable yang bisa disertakan ataupun 

tidak. Fasilitas ini perlu diisi apabila ingin dibuat label (kategorisasi) 

untuk variable tertentu. Label diisi dengan nama kategori misalnya ; jenis 

kelamin. Label yang tidak diisi tidak mempengaruhi proses data. Sebagai 

contoh dobel klik pada kolom label diketik : jenis kelamin. 

Values : untuk data kuantitatif dan tanpa kategorisasi, fasilitas ini dapat diabaikan. 

Untuk melanjutkan contoh, ketik angka 1. Pilihan values berguna pada 

proses pemberian kode. Misalnya untuk jenis kelamin, double klik pada 

kotak values, muncul kotak dialog : 

 
Gambar 2 : Kotak dialog Values 

 

Untuk memberi kode, isikan angka 1 pada kotak value, kemudian ketik 

Wanita pada kotak value Label. Otomatis tombol Add aktif. Tekan tombol 

tersebut, otomatis keterangan 1=”wanita” tampak sebagai kodifikasi 

gender pertama. Lanjutkan dengan mengetik angka 2 pada kotak value dan 

pria pada kotak value Label, lalu tekan Add, lanjutkan OK.  

Missing : adalah data yang hilang atau tidak ada isinya. Jika semuanya lengkap, 

maka bisa diabaikan. 

Column : hamper sama dengan Wdth, berfungsi menyediakan lebar kolom yang 

diperlukan untuk pemsaukan data. 

Align : adalah posisi data (di kiri, tengah atau kanan) 



Measure : adalah hal yang penting di SPSS karena menyangkut tipe variable (skala 

pengukuran) yang nantinya menentukan jenis analisis yang digunakan. 

Untuk data string (karakter) ada 2 pilihan, yaitu data adalah nominal atau 

ordinal.   

 Pemahaman skala pengukuran variabel menggambarkan pemahaman terhadap 

data yang anda miliki. Skala pengukuran dibagi menjadi kategorik (nominal-ordinal) 

dan numerik (rasio-interval).  

Variabel nominal mempunyai kategori yang sederajat atau tidak bertingkat (contoh : 

variabel jenis kelamin, yaitu laki-laki dan perempuan), sedangkan variabel ordinal 

mempunyai kategori yang tidak sederajat atau kategori yang bertingkat (contoh: 

variabel kadar kolesterol baik, kadar kolesterol sedang, dan kadar kolesterol buruk).  

Variabel numerik dapat dibedakan menjadi variabel rasio dan interval. Variabel yang 

mempunyai nilai nol alami, tergolong variabel rasio (contoh : tinggi badan, berat 

badan), sedangkan variabel yang tidak memiliki nilai nol alami termasuk variabel 

interval (contoh: suhu, suhu nol derajat Celcius berbeda dengan nol derajat pada skala 

Fahrenheit) 

Dalam SPSS, variabel rasio dan interval disebut sebagi variabel scale, yang 

dilambangkan dengan gambar penggaris). 

 

 

Jika pengisian pada variable view benar, maka diperoleh hasil seperti  

Pada gambar di bawah ini : 

 

 
Gambar 3 : Variable View 

Mengisi data 

 Untuk menginput data harus dilakukan di area DATA VIEW. Area ini dapat 

dibuka dengan mngklik tab sheet DATA VIEW yang ada di bagian bawah layer, 

atau dengan memilih menu ViIEW, lalu klik submenu DATA. Cara yang lain 

adalah dengan langsung menekan Ctrl+T. Dari pengisian di area variable view 

yang telah dibuat perhatikanlah ada 3 nama variable yang tampak di data view 

ini. 

 

 



Gambar 4 : Data View 

 Untuk mengisi variable nama, letakkan pointer pada baris 1 kolom variable Nama, 

lalu ketik menurun ke bawah sesuai data yang ada. Pengisian seperti mengisi data 

Microsoft Excel, atau mengetik table pada MS Word. Begitu pula dengan 

pengisian variable berat 

 Untuk pengisian variable Gender: 

 Sebelum mengisi data ini, arahkan pointer ke menu utama SPSS, pilihlah menu 

View, lalu klik mouse pda sub menu Value Label. 

Menyimpan Data 

 Data yang telah kita buat dapat disimpan dengan prosedur berikut : 

Dari menu utama SPSS, pilih menu File, kemudian pilih submenu Save As ; beri nama 

file, dan tempatkan pada directory yang dikehendaki. Prosedurnya pada dasarnya 

seperti pada program MS Office. File yang disimpan pada umumnya akan mempunyai 

nama ekstensi (tipe) sav.  

 

C. Memformat data/mengelola data 

Setelah sebuah variable didefinisikan dan data yang ada dimasukkan ke dalam SPSS 

DATA EDITOR, pada data tersebut dapat dilakukan berbagai pengelolaan 

menggunakan Menu Data. Menu ini digunakan untuk melakukan berbagai pengerjaan 

pada data SPSS yang bukan berupa prosedur statistic. Dalam beberapa hal, menu ini  

mempunyai fungsi yang berkaitan dengan menu Edit  

1. Menyisipkan variabel baru 

Kita dapat menyisipkan variable baru pada file data yang telah dibuat. Misalnya 

pada file berat yang terdiri dari 3 variabel akan ditambah dengan variable baru : 

tinggi. Dapat dilakukan dengan cara berikut : 

1) buka file berat, letakkan pointer padasembarang tempat di kolom (variable) 

gender (pada DATA VIEW) 

2) dari menu utama SPSS dipilih menu Data, klik mouse pada pilihan Insert 

Variabel. Maka akan muncul kolom barudengan nama var00004 (atau nama 

batu lainnya) yang merupakanvariabel baru. Untuk pendefinisian/pengisian 

variable (tipe, nama dan lainnya) dapat digunakan perintah sama seperti 

pada pemasukan variable baru yang telah dijelaskan sebelum ini. 

2. Menyisipkan case  

Untuk menyisipkan kasus pada file data kita dapat dilakukan dengan  cara berikut : 

1) letakkan pointer pada sel paling kiri pada posisi baris yang sesuai, misal 

akan disisipkan kasus pada baris ke 3, maka pointer diletakkan pada sel 

paling kiri baris ke 3   

2) pilih submenu Insert Case pada menu DATA atau klik kanan mouse pada 

posisi tadi, lalu klik Insert Case 

3) dengan demikian akan tersedia 1 baris baru yang siap untuk diisi dengan 

kasus yang akan disisipkan. 

3. Mengganti isi data 

Untuk mengganti isi data dapat dilakukan dengan cara sederhana yaitu dengan 

melatakkan pointer pada sel yang akan diganti isinya sehingga tampak terblok, 

langsung ketik dengan data yang baru. 

4. Menghapus data 

Misal dari file berat akan dihapus data atau kasus nomor 5 (lengkap dari nama, 

gender, berat), maka  penggantian dapat dilakukan dengan cara : 

1) letakkan pointer pada angka 5 (kotak paling kiri sehingga tampak seluruh 

kotak di baris tersebut terblok 



2) dari menu utama, pilih menu Edit, pilih Cut, atau klik kanan pada sel 

tersebut pilih cut, atau dengan menekan Ctrl+X yang akan berefek sama 

yaitu hilangnya seluruh kasus. 

3) Jika hanya akan dihapus namanya saja, cukup dihapus dengan cara menekan 

tombol Del pada sel tersebut atau perintah Clea pada menu Edit. 

4) Untuk membatalkan perintah, tekan undo pada toolbar tatu pada menu Edit 

 

5. Mengcopy data 

  Sebuah data (variable) dapat dilakukan proses copy dan paste secara biasa, 

seperti paerlakuan pada sebuah data pada umumnya. yaitu dengan cara mengCopy 

. Paste seperti biasa  

Namun demikian , dalam praktek sering dijumpai proes penggandaan variable 

yang lebih dari satu, untuk itu digunakan submenu PASTE VARIABEL yang 

dijumpai dengan kita membuak pada area Variabel View. 

Jika kita telah memiliki data yang ditulis di MS Excel, kita dapat langsung 

memindah data tersebut ke Data View pada Data Editor SPSS, dengan cara biasa, 

namun untuk dapat melanjutkan ke pengolahan data, maka kita terlebih dahulu 

harus mengidentifikasi variable di Variable View. 

 

6. Mengurutkan data 

 

Untuk bebrapa keperluan khusus, pada data yang banyak terkadang diperlukan 

pengurutan data berdasa variable tertentu. Hal ini dapat dilakukan dengan 

memanfaatkan perintah SORT CASES dengan cara : 

1) sebagai contoh, akan dirurtkan data dari file Berat (yang telah anda buat) 

berdasarkan variable nama, maka untuk memulai, letakkan pointer pada 

sembarang tempat pada file Berat. Klik menu Data, kemudian Sort Cases, 

akan tampak kotak dialog 

2) karena akan diurutkan berdasar Nama, maka klik pada variable nama, dan 

masukkan dalam kolom Sort by 

3) jika pengurutan dilakukan naik ke atasdari abjad A sampai Z, maka klik 

pada pilihan ascending, lalu tekan ok. 

4) Dengan demikian data sudah diurutkan berdasarkan inisial nama, dan data 

berat dan gender akan mengikuti variable nama yang bersangkutan. 

 

D. Keluar dari SPSS 

Setelah seluruh pengerjaan di SPSS dianggap selesai, untuk keluar dari program SPSS 

adalah sama caranya seperti biasa, yaitu dengan menekan submenu Exit yang terdapat 

pada menu File; atau tekan tanda silang di pojok kanan atas. 

 

LATIHAN/TUGAS: 

Latihan pertama pada praktikum ini adalah latihan menginput data dan mengidentifikasi 

data, sekaligus mempraktekkan mengelola/memformat data seperti yang telah dijelaskan.. 

Untuk itu soal akan diberikan pada saat praktikum.  

 

  

 

  



   

G. MATERI II 

H. STATISTIK DESKRIPTIF 

 

Statistik deskriptif lebih berhubungan dengan pengumpulan dan peringkasan data serta 

penyajian hasil peringkasan tersebut. Data-data yang dapat diperoleh dari hasil sensus, 

percobaan, survey, dll umumnya masih acak , mentah dan tidak terorganisir dengan baik (raw 

data). Dari data tersebut harus disusun, diringkas dengan baikdan teratur, baik dalam bentuk 

table atau grafik, sebagai dasar untuk berbagai pengambilan keputusan (statistic Inferensi) 

Untuk mengetahui deskripsi data diperlukan ukuran yang lebih eksak, ukuran statistic 

tersebut disebut summary statistics (ringkasan statistic). Dua kelompok ukuran statistic yang 

sering digunakan dalam pengambilan keputusan adalah : 

1. Mencari Central Tendency (kecenderungan terpusat) seperti : Mean, Median dan 

Modus 

2. Mencari ukuran Dispersi, seperti Standart Deviasi, Varians 

Untuk menggambarkan data digunakan menu Descriptive Statistic. Menu-menu yang   

berhubungan dengan statistic deskriptif adalah : Frequencies, Descriptive, Explore, Crosstab, 

dan Ratio pada submenu Descriptif Statistics yang terdapat pada menu Analyze, sedangkan 

Case Summaries pada submenu Report. 

 

1. Frequencies 

Membahas beberapa ukuran statistic dasar, seperti Mean, Median, Kuartil, Persentil, 

Standard Deviasi, dan lainnya. Fungsi utama dari FREQUENCIES adalah memberi 

gambaran sekilas dan ringkas (first look) dari sekelompok data. 

2. Descriptive 

Lebih kompleks daripada FREQUENCIES, menu ini dapat menyajikan ukuran statistic 

beberapa variable dalam satu table, serta mengetahui skor z dari satu distribusi data. Skor 

z biasa digunakan untuk pengujian kenormalan distribusi data. 

3. Explore 

Menu ini lebih lengkap daripada menu DESCRIPTIVES, berfungsi untuk memeriksa lebih 

teliti sekelompok data, antaralain data screening, menguji ada tidaknya outlier, uji asumsi 

kenormalan data dan kesamaan varians, serta penganganan data per subgroup atau per 

kasus. 

4. Crosstab 

Digunakan untuk menyajikan deskripsi data dalam bentuktabel silang (crosstab) yang 

terdiri atas baris dan kolom. Selain itu, menu ini juga dilengkapi dengan analisis hubungan 

di antara baris dan kolom, seperti independensi di antara mereka, besar hubungannya dan 

lainnya (hal inisebenarnya termasuk pada statistic induktif atau inferensi, dan merupakan 

perluasan dari statistic deskriptif. 

5. Ratio 

Menu ini menyediakan ringkasan statistic untuk data hasil perbandingan dua data tertentu. 

Berbeda dengan menu lainnya, menu ini hanya menangani perbandingan dua data, bukan 

satu dat yang bersifat sendiri. 

6. Case Summaries 

Menu ini digunakan untuk melihat lebih jauh isi statistic deskripsi yang meliputu subgroup 

dari sebuah kasus, seperti kasus dengan grup Pria dan Wanita; pada grup ini bias dibuat 

subgroup untuk pria berusia remaja dan dewasa, dan dapat pula dibagi lagi pada remaja 

yang tinggal di kota atau kombinasi lainnya. 



 

FREQUENCIES  

 Untuk latihan, cobalah untuk membuat file data seperti di bawah ini. Data di bawah adalah 

data tinggi dan jenis kelamin mahasiswa Fakultas Kedokteran Angkatan 2009.. 

 

 

 

  
 

NB : untuk variabel gender, angka 1 berarti responden berjenis kelamin pria, sedangkan angka 

2 berarti responden wanita (gunakan Value Label) 

Cobalah untuk memasukkan data seperti yang telah dijelaskan di bab 1. Mulailah dengan 

mendefinisikan variabel pada Variabel View. Setelah itu, lanjutkan dengan mengisikan 

data pada Data View, seperti pada data di atas. Silakan simpan data ini dengan nama file 

DESKRIPTIF. Lanjutkan dengan melakukan analisis statistic berikut ini : 

 

Tabel frekuensi dan statistic deskriptif untuk variabel tinggi 

 Variabel tinggi termasuk data kuantitatif sehingga dapat dibuat table frekuensi serta 

statistic yang meliputi Mean, SD, Skewness, dll. Selain itu, akan dilengkapi dengan Chart yang 

sesuai untuk data tersebut, yaitu histogram atau Bar Chart 

 Coba lakukan analisis statistic dengan langkah seperti berikut ini (masih pada file 

Deskriptif) 

 Klik menu Analyze → Descriptive Statistics → Frequencies, sehingga tampak kotak dialog 

seperti di bawah ini 

 



 
Gambar 5 : kotak dialog Frequencies 

 

Pengisian : 

1. pada kotak variabel isi dengan tinggi, dengan cara sorot tulisan tinggi pada kotak kiri, lalu 

klik pada kotak panah di tengah sehingga tulisan tinggi masuk kedalam kotak variabel 

2. klik Statistics, sehingga tampak kotak dialog Statistics berikut : 

 

 
Gambar 6: Kotak Dialog Statistics 

 Pilihan Statistics meliputi berbagai ukuran statistic untuk menggambarkan data 

(statistic Deskriptif) 

Pengisian 

  Pada petunjuk ini hanya akan dijelaskan beberapa ukuran statistic yang sering 

dipergunakan untuk menggambarkan data. 

Dispersion: 

 Atau penyebaran data, pilihlah keenam jenis pengukuran disperse yang ada, yaitu SD, 

Variance, Range, Minimum, maximum, SE Mean. 

Central Tendency 

 Atau pusat pengukuran data, yang biasa digunakan adalah Mean dan Median 

Tekan continue setelah selesai input untuk melanjutkan proses berikutnya. Lalu tekan ok. 

Namun jika masih ingin melakukan proses yang lain, misalnya membuat grafik (chart). 

Sebelum tekan ok, tekan dulu Charts sehingga tampak kotak dialog Charts. 

Cara pengisian Charts : 



1. tekan charts, lalu pada pilihan Charts type.pilih charts yang akan dibuat, untuk latihan 

ini, pilihlah Histogram dan untuk menampilkan kurva normal, pilih juga With 

normal curve. Lanjutkan dengan menekan Continue. 

2. klik pilihan Format, hal ini berhubungan dengan susunan format data. Pada Order 

by kita bias tentukan susunan data akan dimulai dari nilai terkecil ataukah sebaliknya. 

Untuk keseragaman pada latihan ini silakan tekan Ascendeing values. Abaikan 

bagian lain, lalu tekan Continue, dilanjutkan dengan ok 

   

Output SPSS dan analisis 

Output  

Statistics 

 

tinggi  

N Valid 25 

Missing 0 

Mean 169.400 

Std. Error of Mean .9927 

Median 168.900 

Std. Deviation 4.9633 

Variance 24.634 

Range 20.7 

Minimum 159.6 

Maximum 180.3 

 

tinggi 

 

  

Frequenc

y Percent 

Valid 

Percent 

Cumulative 

Percent 

Valid 159.6 2 8.0 8.0 8.0 

161.3 1 4.0 4.0 12.0 

164.8 2 8.0 8.0 20.0 

167.2 2 8.0 8.0 28.0 

168.5 2 8.0 8.0 36.0 

168.6 1 4.0 4.0 40.0 

168.9 3 12.0 12.0 52.0 

170.2 1 4.0 4.0 56.0 

170.4 3 12.0 12.0 68.0 

172.5 4 16.0 16.0 84.0 

174.5 2 8.0 8.0 92.0 

177.5 1 4.0 4.0 96.0 

180.3 1 4.0 4.0 100.0 

Total 25 100.0 100.0   

 

Analisis 

• N adalah jumlah data yang valid = 25 buah 

• Missing (data yang hilang) = 0 

• Mean (rata-rata) tinggi adalah = 169.400 cm 

• Std.Error of mean = 0.993 cm. penggunaan Standard error of mean untuk 

memperkirkn besar rat-rata populasi yang diperkirakan dari sample. Untuk itu, 



dengan standard error of mean tertentu dan pada tingkat kepercayaan 95% (SPSS 

sebagian besar menggunakan angka ini sebagai standar), rata-rata populasi 

menjadi : 

• Rata-rata ± 2 standard error of mean 

• NB : angka 2 digunakan karena tingkat kepercayaan 95% 

Maka : 

169,4 cm ± ( 2 x 0,993 cm) = 167,414 sampai 171,386 cm 

• Median atau titik tengah data jika semua data diurutkan dan dibagi dua sama 

besar. Angka median 168,9 cm menunjukkan bahwa 50% tinggi badan adalah 

168,9 cm ka atas dan 50%-nya adalah 168,9 cm ke bawah 

• Standard Deviasi adalah 4,963 cm dan varians yang merupakan kelipatan standard 

deviasi adalah 24,634 cm 

Penggunaan  SD untuk menilai dispersi rata-rata dari sample. Untuk itu dengan Sd 

tertentu dan pada tingkat kepercayaan 95% (SPSS biasa menggunakan angka ini 

sebagai standar) rata-rata tinggi badan menjadi : 

Rata-rata ± 2 SD 

NB : angka 2 digunakan karena tingkat kepercayaan 95%  

Maka : 

 169,4 cm ± (2 x 4,963 cm) = 159,474 sampai 179,326 cm 

Perhatikan kedua  batas angka yang berbeda tipis dengan nilai minimum dan 

maksimum. Ini membuktikan sebaran data adalah baik. 

• Data minimum adalah 159,6 cm sedangkan data maksimum adalah 180,3 cm 

• Range adalah data maksimum – data minimum, atau dalam kasus ini : 

  180,3 cm – 159,6 cm = 20,7 



 
 Analisis histogram : 

 Grafik histogram yang telah dibuat frekuensinya, terlihat bahwa batang histogram 

mempunyai kemiripan dengan kurva normal (berbentuk seperti lonceng) yang 

disertakan. Ini membuktikan bahwa distribusi tersebut sudah dapat dikatakan normal 

atau mendekati normal. Namun pengujian normalitas sendiri akan dibahas pada materi 

berikut ini. 

 

Menguji Normalitas Data dan Varians 

 Kita harus terampil melakukan dan menginterpretasikan apakah suatu data memiliki 

distribusi normal atau tidak, karena pemilihan penyajian data dan uji hipotesis yang 

dipakai tergantung dari normal tidaknya distribusi data. 

 Jika disrtribusi data normal, maka dianjurkan untuk menyajikan data dengan 

menggunakan mean dan standar deviasi, sedangkan jika distribusi data tidak normal 

dianjurkan menggunakan median dan minimum-maksimum sebagai pasangan ukuran 

pemusatan dan penyebaran. 

 Untuk pemilihan uji hipotesis, jika distribusi data normal, maka digunakan uji 

parametrik, namun jika distribusi data tidak normal, dipilih uji nonparametrik. 

 

Untuk menilai normal tidaknya distribusi data, ada 2 metode, yaitu dengan : 

A. metode deskriptif 

Dengan melihat output SPSS pada bagian Deskriptif, berdasarkan koefisien varians, rasio 

skewness dan kurtosis, histogram, Q-Q plot, Detrendended normal Q-Q plot (langkah 

lengkap, lihat di bawah) 
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B. metode analitik 

Dengan menggunakan uji Kologorov-Smirnov (untuk sampel banyak:>50) atau Shapiro-

Wilk. (untuk sampel sedikit:≤ 50) 

 

Tabel 1 :  Metode untuk mengetahui suatu set data berdistribusi normal atau tidak 

Metode Parameter 
Kriteria distribusi data 

dikatakan normal 
Keterangan 

Deskriptif 

Koefisien varian Nilai koefisien varians , 

30% 

SD   x 100% 
Mean 

Rasio Skewness Nilai rasio skewness -2s/d 2 
Skewness 
SE Skewness 

Rasio Kurtosis Nilai rasio Kurtosis -2 s/d 2 
Kurtosis 
SE Kurtosis 

Histogram Simetris tidak miring kiri 

atau kanan, tidak terlalu 

tinggi, tidak terlalu rendah 

 

Box plot Simetris, median tepat di 

tengah, tidak ada outlier 

atau nilai ekstrim 

 

Normal Q-Q plots Data menyebar sekitar garis  

Detrended Q-Q plots Data menyebar sekitar garis 

pada nilai 0 

 

Analitik 

Kolmogorov-

Smirnov 

Nilai kemaknaan (p)>0,05 Untuk sampel 

besar (>50) 

Shapiro-Wilk Nilai kemaknaan (p)>0,05 Untuk sampel kecil 

(≤50) 

 

 Salah satu konsep penting dalam statistic inferensi adalah : 

• Apakah beberapa sample yang telah diambil berasal dari populasi yang sama (populasi 

data berdistribusi normal) ? 

• Apakah sampel-sampel tersebut mempunyai varians yang sama? 

• Pengujian kenormalan data dapat dilakukan dengan gambar ataupun uji skewness dan 

kurtosis. Dengan kasus yang sama yaitu tinggi badan akan diuji kenormalan dan 

kesamaan varians dari sample dengan bantuan uji  SHAPIRO-WILK dan LILLIEFORS 

serta gambar NORMAL PROBABILITY PLOTS. 

 

Langkah-langkah pengujian 

➢ Kerjakan untuk file deskriptif, ikuti prosedur berikut : 

➢ Dari menu utama SPSS pilih menu Analyze → Descriptive Statistics 

➢ Pilih submenu Explore, sehingga tampak kotak dialog seperti di bawah ini : 

 



 
Gambar 7 : Kotak dialog Explore 

Pengisian : 

➢ Dependent List, klik variable tinggi kemudian klik tanda ‘>’ (yang sebelah atas), maka 

variable tinggi berpindah ke Dependent List 

➢ Factor List, klik variable gender, kemudian klik tanda ‘>’ yang sebelah atas), maka 

variable gender akan berpindah ke Factor List. 

➢ List cases by atau kasus akan diurutkan menurut variable mana? Dalam kasus ini karena 

variable hanya dua dan semua sudah masuk ke dependent  dan factor, maka isian tersebut 

bisa diabaikan. 

➢ Lanjutkan dengan klik pilihan Statistics : terlihat default SPSS yang memilih 

Description. Untuk keseragaman, biarkan saja pilihan tersebut 

NB : bagaimanapun kotak pilihan ini harus terisi karena SPSS akan menolak jika semua 

pilihan ditiadakan. 

➢ Tekan Continue setelah selesai input, untuk melanjutkan proses berikutnya. 

➢ Lanjutkan dengan klik pilihan Plots, pilihlah : 

➢ Pada Box plot, pilihlah None karena tidak akan dibuat Boxplot 

➢ Pada Descriptive, tidak usah memilih apapun, kecuali akan dibuat Stem dan Leaf 

atau histogram. Jika default menunjuk salah satu pilihan tersebut, maka 

lakukanlah deselect (klik untuk menghapus tanda  ) 

➢ Klik pilihan Normality Plots with test. Pilihan ini untuk membuat gambar uji 

normalitas 

➢ Pada pilihan Spread vs Level with Levene Test, pilih Power estimation untuk 

menguji kesamaan varians 

➢ Tekan Continue 

➢ Pada Display awal tampak pilihan Both, Statistic & Plots, pilihlah Both 

➢ Tekan Ok jika semua pengisian sudah selesai  

 

Output SPSS dan Analisis 

Output  

 

Explore 

 

gender 

  



Case Processing Summary 

 

  

gende

r 

Cases 

Valid Missing Total 

N Percent N Percent N Percent 

tinggi pria 11 100.0% 0 .0% 11 100.0% 

wanit

a 
14 100.0% 0 .0% 14 100.0% 

 

 

 Descriptives 

 

  gender   Statistic 

Std. 

Error 

tinggi pria Mean 172.482 .9886 

95% 

Confidence 

Interval for 

Mean 

Lower 

Bound 
170.279   

Upper 

Bound 
174.684   

5% Trimmed Mean 172.269   

Median 172.500   

Variance 10.750   

Std. Deviation 3.2787   

Minimum 168.5   

Maximum 180.3   

Range 11.8   

Interquartile Range 4.3   

Skewness 1.263 .661 

Kurtosis 2.546 1.279 

wanita Mean 166.979 1.2778 

95% 

Confidence 

Interval for 

Mean 

Lower 

Bound 
164.218   

Upper 

Bound 
169.739   

5% Trimmed Mean 166.804   

Median 167.850   

Variance 22.859   

Std. Deviation 4.7811   

Minimum 159.6   

Maximum 177.5   

Range 17.9   

Interquartile Range 5.3   

Skewness .213 .597 

Kurtosis .745 1.154 

 

 

 Tests of Normality 

 

  Kolmogorov-Smirnov(a) Shapiro-Wilk 



gende

r Statistic df Sig. Statistic df Sig. 

tinggi pria .225 11 .125 .882 11 .110 

wanit

a 
.166 14 .200(*) .927 14 .279 

*  This is a lower bound of the true significance. 

a  Lilliefors Significance Correction 

 

 

Analisis dari output test of normality 

Pedoman pengambilan keputusan : 

➢ Nilai Sig. atau signifikansi atau probabilitas < 0,05, distribusi adalah tidak normal 

(simetris) 

➢ Nilai Sig. atau significansi atau nilai probabilitas > 0,05 distribusi adalah normal 

(simetris) 

 

Ada 2 macam alat uji kenormalan distribusi data yang biasa digunakan yaitu : 

• Komogorov Smirnov dengan keterangan adalah sama dengan uji Liliefor (lihat tanda 

“a” di bawah table). Diperoleh baik untuk gender pria maupun wanita, tingkat 

significansi atau nilai probabilitas di atas 0,05 (0,125 dan 0,200 lebih besar dari 0,05); 

maka dapat dikatakan distribusi kedua sample adalah normal. 

• Shapiro Wilk baik untuk gender pria maupun wanita, tingkat significansi atau nilai 

probabilitas di atas 0,05 (0,125 dan 0,344 lebih besar dari 0,05; maka dapat dikatakan 

distribusi tinggi badan pria dan wanita adalah normal 

 

 

Test of Homogeneity of Variance 

 

    

Levene 

Statistic df1 df2 Sig. 

tinggi Based on 

Mean 
1.507 1 23 .232 

Based on 

Median 
1.260 1 23 .273 

Based on 

Median and 

with adjusted 

df 

1.260 1 21.148 .274 

Based on 

trimmed 

mean 

1.549 1 23 .226 

 

 

Analisis dari output  test of Homogenity  

Output ini untuk menguji apakah dua sample yang diambil mempunyai varians yang sama. 

Pedoman pengambilan leputusan : 

➢ Nilai Sig, atau signifikansi atau nilai probabilitas < 0,05, data berasal dari populasi-

populasi yang mempunyai varians tidak sama 



➢ Nilai Sig, atau signifikansi atau nilai probabilitas > 0,05, data berasal dari populasi-

populasi yang mempunyai varians sama 

Pada output di atas, ada satu alat uji yang digunakan, yaitu Levene test. Hasil pengujian 

menunjukkan tingkat signifikansi atau nilai probabilitas mean (rata-rata) yang berada di atas 

0,05 (0,232 lebih besar dari 0,05). Demikian pula jika dasar pengukuran adalah median data, 

angka Sig. adalah 0,273 yang tetap di atas 0,05. Maka bisa dikatakan data berasal dari populasi-

populasi yang mempunyai varians sama, atau sample pria dan wanita tersebut di atas di ambil 

dari populasi pria dan wanita yang mempunyai varians tinggi badan sama, dalam arti varians 

populasi tinggi badan pria sama dengan populasi tinggi badan wanita. 

 

Normal Q-Q Plots
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Pada gambar Q-Q plot untuk variable tinggi, baik untuk gender pria maupun wanita, terlihat 

ada garis lurus dari kiri bawah ke kanan atas. Garis ini berasal dari nilai z(lihat pembahasan z 

pada materi kuliah). Jika suatu distribusi data normal, maka dataakan tersebuar d sekeliling 

garis. Pada kasus ini terlihat bahwa memang data tersebar di sekeliling garis (kecuali ada 1 data 

pria dan 1 data wanita yang “outlier”. 
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Detrended Normal Q-Q Plots 
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Kedua output ini mendeteksi pola-pola dari titik-titik yang bukan dari kurva normal. Terlihat 

pada kedua gender sebagian besar data terpola di sekitar garis garis , kecuali 2 buah data yang 

masing-masing ada di pojok kanan atas. Hal ini membuktikan bahwa distribusi data adalah 

normal. 

 

Latihan/tugas: 

 Mahasiswa diberi contoh set data (diberikan pada saat praktikum) untuk diinput dan 

selanjutnya mempraktekkan melakukan uji normalitas dengan cara-cara yang telah diberikan 

sekaligus menginterpretasi hasil uji tersebut. 
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I. MATERI III 

J. STATISTIK INFERENSI 

 

 Pada pembahasan mengenai statistic deskriptif telah diketahui bahwa untuk mengetahui 

karakteristik sebuah populasi dilakukan prosedur statistic deskriptif. Dari prosedur itu dapat 

diperoleh hasil berupa parameter yang menggambarkan ciri-ciri populasi tersebut. Jika 

populasi tidak begitu besar, hal ini tidak menimbulkan kesulitan. Namun jika populasi begitu 

besar, misalnya mencakup balita di seluruh Indonesia, tentunya akan menimbulkan kesulitan 

untuk melakukan  penggambaran yang jelas tentang populasi dan berbagai pengambilan 

keputusan sehubungan dengan ciri-ciri populasi. Untuk itu dapat dilakukan pengambilan 

sample sejumlah tertentu populasi tersebut kemudian dengan sample tersebut dilakukan 

berbagai keputusan (inferensi) terhadap populasi, yaitu : 

• Melakukan perkiraan (estimasi) terhadap populasi, 

Misalnya : berapa rata-rata populasi? Berapa deviasi standarnya? 

• Melakukan uji hipotesis terhadap parameter populasi 

Misal : apakah rata-rata populasi yang diperkitrakan sudah benar? 

Dengan kata lain, dari informasi sample yang telah ada akan dilakukan berbagai penggambaran 

dan kesimpulan terhadap isi populasi. Kegiatan itu disebut statistic inferensi 

 Dalam prakteknya, metode statistic inferensi cukup beragam, dan salah satu criteria 

penting dalam pemilihan metode statistic yang akan digunakan adalah melihat distribusi sebuah 

data. Jika data yang diuji berdistribusi normal atau mendekati normal, maka selanjutnya dengan 

data-data tersebut dapat dilakukan berbagai inferensi atau pengambilan keputusan dengan 

metode statistic parametric. 

 Tetapi jika terbukti data tidak berdistribusi normal atau jauh dari criteria distribusi 

normal, maka tidak dapat digunakan metode parametric, sehingga untuk kegiatan inferensi 

digunakan statistic nonparametric. 

Kegiatan inferensi dapat dibedakan menjadi : 

• Pengujian beda rata-rata, yang meliputi uji t dan uji F (Anova) 

• Pengujian asosiasi (hubungan) dua variable atau lebih, alat uji yang digunakan seperti Chi-

square, korelasi dan regresi. 

  



Macam-macam uji hipotesis sesuai dengan skala pengukuran dapat dilihat pada tabel berikut 

ini : 

Tabel  2 : skala pengukuran dan uji hipotesis yang digunakan 

Skala pengukuran 
Jenis Hipotesis 

Komparatif Korelatif 

Numerik 

Tidak berpasangan Berpasangan Pearson 

 2 kelompok >2 

kelompo

k 

2 kelompok > 2 

kelompok 

Uji t tidak 

berpasangan 

 

One way 

ANOVA 

Uji t 

berpasanga

n 

Repeated 

ANOVA 

Kategorik (Ordinal) Mann 

Whitney 

Kruskal 

Wallis 

Wilcoxon Friedman Spearman 

Sommers 

Gamma 

Kategorik  

( Nominal/Ordinal) 

Chi-Square 

Fisher 

Kolmogorov-Smirnov 

Mc Necmar, Cochran 

Marginal Homogenity 

Wilcoxon, Friedman 

Koefisien 

Kontngens

i Lambda 

 

 

 

Statistic Inferensi dalam SPSS 

 SPSS menyediakan berbagai metode parametrik untuk melakukan inferensi terhadap 

data statistic. Beberapa menu statistic parametric yang tersedia dalam SPSS adalah ; 

COMPARE MEANS, General Linear Model (GLM), CORRELATE dan REGRESSION. 

COMPARE MEANS 

Menu ini meliputi : 

• MEANS 

• Uji t, yang meliputi :  

o Uji t satu sample (One Sample t Test) 

o Uji t untuk 2 sampel independent (Independent Sample t Test) 

o Uji t untuk 2 sampel berpasangan (Paired Sampel t Test) 

• One Way Anova : jika uji t untuk 2 sampel, maka Anova digunakan untuk menguji lebih 

dari 2 sampel 

 

General Linear Model 

GLM merupakan kelanjutan dari ANOVA, yaitu pada GLM dibahas satu variable dependen 

namun mempunyai satu atau lebih factor. 

 

CORRELATE 

Membahas uji hubungan antara dua variable 

 

REGERESSION 

Membahas pembuatan model regresi untuk menggambarkan hubungan dua variable atau lebih 

 

 Paired Sample t Test (Uji t berpasangan) 

Fasilitas ini digunakan untuk menguji 2 sampel yang berpasangan (paired). Paired dalam hal 

ini diartikan sebagai sebuah sample dengan subjek yang sama, namun mengalami 2 perlakuan 



atau pengukuran yang berbeda, seperti subjek A mendapat perlakuan I kemudian perlakuan II. 

Contoh berikut akan menjelaskan hal ini. 

 

Contoh : 

Produsen obat penurun berat badan ingin mengetahui apakah obat yang diproduksinya benar-

baner mempunyai efek terhadap penurunan berat badan konsumennya. Untuk itu diambil 

sample yang terdiri dari 10 orang yang   masing-masing diukur berat badannya sebelum 

menggunakan obat tersebut. setelah sebulan mengkonsumsi obat tersebut secara rutin dan 

teratur, kembali sample diukur berat badannya. Berikut adalah hasilnya (dalam kilogram) 

 

 Sebelum Sesudah  Sebelum Sesudah 

1 76.85 76.22 6 88.15 82.53 

2 77.95 77.89 7 92.54 92.56 

3 78.65 79.02 8 96.25 92.33 

4 79.25 80.21 9 84.56 85.12 

5 82.65 82.65 10 88.25 84.56 

 

Penyelesaian : 

 Perhatikan ciri dari sample berpasangan, yakni subjeknya tetap sepuluh orang; kepada 

setiap orang tersebut diberikan 2 kali perlakuan, yang dalam kasus ini adalah efektivitas sebuah 

obat. Kasus di atas terdiri atas 2 sampel yang berhubungan atau berpasangan satu dengan yang 

lain, yaitu sample sebelum makan obat dan sample sesudah makan obat. Di sini populasi 

berdistibusi normal dan karena sample sedikit, dipakai uji t untuk 2 sampel yang berpasangan 

(paired) 

Tugas : 

Cobalah untuk memasukkan data di atas pada data editor SPSS. Lanjutkan dengan pengolahan 

data dengan langkah-langkah berikut : 

 Simpanlah data yang telah anda buat dengan nama uji t paired dan tempatkan pada direktori 

yang dikehendaki 

 Bukalah file tadi, pilih menu ANALYZE → Compare-Means 

 Pilih Paired-Sample T Test sehingga tampak kotak dialog seperti ini : 

 
Gambar  3.1 : kotak dialog Paired t Test 

Pengisian : 

 Karena akan diuji data sebelum dan sesudah, maka klik variable sebelum, lanjutkan dengan 

klik variable sesudah,  lanjtkan dengan meng-klik kotak kecil bertanda “>” maka pada 

kotak Paired Variable terlihat : sebelum-sesudah. 

NB : variable sebelum dan sesudah harus dipilih bersamaan, jika tidak, SPSS tidak dapat 

menginput dalam kolom Paired Variable. 

 



 
Gambar 3.2 : Kotak dialog Option 

Pengisian : 

 Confidence Interval : atau tingkat kepercayaan, sebagai default, SPSS menggunakan 

tingkat kepercayaan 95% atau tingkat signifikansi 100%-95% = 5%. 

 Missing Value atau data yang hilang, karena data komplit, maka abaikan bagian ini (tetap 

pada default SPSS, yaitu Exclude case analysis by analysis) 

 Tekan Continue jika pengisian dianggap selesai, lanjutkan dengan klik Ok untuk 

mengakhiri pengisian prosedur analisis. 

 

 

Output  

T test 

 Paired Samples Statistics 

 

  Mean N 

Std. 

Deviation 

Std. 

Error 

Mean 

Pair 1 sebelu

m 
84.5100 10 6.63931 2.09953 

sesuda

h 
83.3090 10 5.58235 1.76530 

 

 Paired Samples Correlations 

 

  N 

Correlatio

n Sig. 

Pair 1 sebelum & 

sesudah 
10 .943 .000 

 

   

Paired Samples Test 

 

 Paired Samples Test 

 

  

Paired Differences 

t df 

Sig. 

(2-

tailed) Mean 

Std. 

Deviat

ion 

Std. 

Error 

Mean 

95% 

Confidence 

Interval of the 

Difference 

Lower Upper 



Pair 

1 

sebel

um - 

sesud

ah 

1.2010

0 

2.3073

8 

.7296

6 

-

.44960 

2.8516

0 

1.64

6 
9 .134 

 

 

 

Analisis  

Output Bagian 1 

Output ini menunjukkan ringkasan statistic dari kedua sample. Berat badan sebelum minum 

obat rata-rata 84,51 kg, sedangkan setelah minum obat, konsumen mempunyai rata-rata berat 

badan 83,3090 kg 

 

Output bagian 2 

Output menunjukkan korelasi antara kedua variable yang menghasilkan angka  0,943 dengan 

nilai probabilitas jauh di bawah 0,05 (lihat nilai signifikansi output yang 0,000) ini menyatakan 

bahwa korelasi antara berat sebelum dansesudah minum obat adalah sangat erat dan benar-

benar berhubungan secara nyata. 

 

Output bagian 3 

Hipotesis  

H0 = kedua rata-rata populasi adalah identik (rata-rata populasi berat sebelum minum obat dan 

sesudah minum obat adalah sama/tidak berbeda secara nyata) 

H1 = kedua rata-rata populasi adalah tidak identik (rata-rata populasi berat sebelum minum obat 

dan sesudah minum obat adalah tidak sama/ berbeda secara nyata) 

 

Pengambilan keputusan  

a. Berdasarkan perbandingan t hitung dengan t table (dasar pengambilan keputusan 

sama dengan uji t) : 

Jika statistic hitung (angka t output) > statistic table (table t), maka H ditolak 

Jika statistic hitung (angka t output) < statistic table (table t), maka H diterima 

T hitung dari output adalah 1,646 

Sedang statistic table dapat dilihat pada table t : 

• Tingkat signifikansi () adalah 5% (lihat input data pada bagian OPTION yang memilih 

tingkat kepercayaan 95% 

• Df atau derajat kebebasan adalah n (jumlah data) - 1atau 10 – 1 = 9 

• Uji dilakukan dua sisi karena akan diketahui apakah rata-rata sebelum sama dengan 

sesudah ataukah tidak. Jadi dapat lebih besar atau lebi kecil, karenanya dipakai uji dua 

sisi. Perlunya uji dua sisi dapat diketahui pula dari output SPSS yang menyebut adanya 

Two tailed test. 

Dari table t, diperoleh angka 2,2622 

Oleh karena t hitung terletak pada daerah H0 diterima, maka berarti obat tersebut tidak efektif 

dalam upaya menurunkan berat badan 

 

b. Berdasarkan nilai probabilitas : 

• Jika probabilitas > 0,05, maka H0 diterima 

• Jika probabilitas < 0,05, maka H0 ditolak 

Keputusan : 



Terlihat bahwa t hitung adalah 1,646 dengan probabilitas 0,134 (> 0,05) maka H0 diterima atau 

dapat diartikan bahwa berat badan (BB) sebelum dan sesudah minum obat relative sama. Atau 

dengan kata lain, obat penurun BB tersebut tidak efektif dalam menurunkan BB secara nyata. 

Pada prinsipnya pengambilan keputusan berdasar t hitung dan t table ataupun berdasar angka 

probabilitas adalah sama hasilnya. Tetapi untuk kemudahan dan kepraktisan, penggunaan 

angka probabilitas lebih sering digunakan sebagai dasar pengambilan keputusan inferensi. 

Catatan : 

Dalam kasus ini ,dapat pula dinyatakan bahwa terdapat perbedaan Mean sebesar 1,2010. angka 

ini berasal dari : 

 BB sebelum minum obat – BB sesudah minum obat 

 = 84,5100 kg– 83,3090 kg = 1,2010 kg 

Perbedaan ini memiliki range antara lower (batas bawah) sebesar -0,4496 (tanda negative 

berarti BB sebelum minum obat < BB sesudah minum obat) sampai upper (batas atas) 2,8516 

kg. Walau demikian, dari uji t terbukti bahwa perbedaan 1,2010 kg dengan range > 0 kg - -

2.8616 kg tersebut tidak cukup berarti untuk menyatakan bahwa obat tersebut efektif untuk 

menurunkan BB. 

 

One Sample t Test 

 Pengujian satu sample pada prinsipnya bertujuan untuk menguji apakah suatu nilai 

tertentu (yang diberikan sebagi pembanding) berbeda secara nyata ataukah tidak dengan rata-

rata sebuah sample. 

Sebagai contoh, diduga rata-rata konsumsi rokok pada karyawan PT X  adalah sebanyak 3 

batang perhari. Jika seluruh karyawan PT X dianggap populasi, maka angka tersebut adalah 

suatu parameter. Selanjutnya akan dibuktikan secara statistic apakah konsumsi tersebut 

memang benar demikian. Untuk itu diambil sejumlah sample dan pada sample itu dilakukan 

perhitungan rata-rata konsumsi rokok perhari. Kemudian dilakukan proses pembandingan yang 

disebut sebagai uji satu sample (one sample test). Digunakan uji t karena jumlah sample yang 

diambil pada uji semacam itu kurang dari 30 buah. 

Untuk mudah dan cepatnya, kita gunakan data BB pada kasus Paired t test, hanya saja kita 

gunakan data yBB sebelum minum obat. 

Misalnya diduga populasi rata-rata berat sebelum minum obat = 84,51 kg (lihat output 

terdahulu), untuk membuktikan hal tersebut, sekelompok anak muda ditimbang, dan mereka 

mempunyai BB rata-rata 90 kg. dengan data di atas, apakah dapat disimpulkan bahwa berat 

rata-rata populasi memang 84,51 kg ? 

 



Penyelesaian : 

Kasus di atas terdiri atas 1 sampel yang akan dipakai dengan nilai populasi hipotesis yaitu 90 

kg. Di sini populasi diketahui berdistribusi normal, dan karena sample sedikit, digunakan uji t.  

• Data diinput seperti cara yang sudah dipraktekkan pada latihan sebelum ini. Atau pada 

kasus ini digunakan data file yang sudah ada. 

• Pengolahan data, ikuti langkah-langkah berikut : 

o Buka ;embar kerja file uji t paired yang telah ada 

o Klik menu Analyze → Compare Means → One Sampel t Test, sehingga tampak kotak 

dialog : 

 
Gambar 3.3: kotak dialog One Sample t Test 

Pengisian : 

❖ Masukkan variable sebelum ke dalam kotak Test Variable, dengan cara : sorot variable 

sebelum → klik kotak panah kecil 

❖ Ketik 90 pada kotak Test Value (karena akan diuji nilai hipotesis 90 kg 

❖ Karena tidak ada data missing dan tingkat kepercayaan tetap 95%, abaikan pilihan 

OPTIONs 

❖ Tekan OK untuk proses data 

 

Output dan analisis  

T test  

 

One-Sample Statistics 

 

  N Mean 

Std. 

Deviation 

Std. 

Error 

Mean 

sebelum 10 84.5100 6.63931 2.09953 

 

 

Output di atas menunjukkan ringkasan statistic dari variable sebelum. Rata-rata BB sebelum 

minum obat adalah 84,51 kg.  

 

  



One-Sample Test 

 

  

Test Value = 90 

t df 

Sig. (2-

tailed) 

Mean 

Differenc

e 

95% Confidence 

Interval of the 

Difference 

Lower Upper 

sebelum -2.615 9 .028 -5.49000 -10.2395 -.7405 

 

Hipotesis : 

H0 =  berat kelompok anak muda tidak berbeda dengan rata-rata berat populasi sebelum minum 

obat 

H0 = berat kelompok anak muda berbeda dengan rata-rata berat populasi sebelum minum obat  

Pengambilan keputusan 

a. Berdasarkan perbandingan t hitung dan t Tabel 

❖ Jika statistic hitung (angka t output) > statistic table (table t), maka H0 ditolak 

❖ Jika statistic hitung (angka t output) < statistic table (table t), maka H0 diterima 

T hitung dari output adalah -2,615 

Sedang statistic table dapat dihitung pada table t : 

❖ Tingkat significansi (α) adalah 5% (lihat input data pada bagian OPTIONSyang memilih 

tingkat kepercayaan 95% 

❖ Df atau derajat kebebasan adalah n(jumlah data) – 1 atau 10 – 9 = 9 

❖ Uji dilakukan 2 sisi karena akan dicari apakah rata-rata sebelum sama dengan berat anak 

muda ataukah tidak. Jadi dapat lebih kecil atau lebih besar.Perlunya Uji 2 sisi dapat 

diketahui pula dari output SPSS yang menyebut adanya Two tailed test. 

❖ Karena t hitung terletak pada daerah H0, maka dapat disimoulkan bahwa berat kelompok 

anak muda tersebut memang berbeda dengan berat rat-rata populasi sebelum minum obat. 

 

b. Berdasarkan probabilitas 

❖ Jika probabilitas > 0,05, maka H0 diterima 

❖ Jika probabilitas < 0,05, maka H0 ditolak 

Keputusan : 

T hitung = -2,615 dengan probabilitas 0,028 (<0,05) maka H0 ditolak atau berarti berat 

kelompok anak muda tersebut memang berbeda dengan berat rata-rata populasi sebelum 

minum obat. 

 

Independent Sample t Test (Uji t tidak berpasangan) 

= uji t untuk 2 sampel independent (bebas) 

Contoh kasus : 

Seorang peneliti ingin mengetahui ada tidaknya perbedaan tinggi dan berat badan seorang pria 

dan seorang wanita. Untuk itu , 7 pria dan 7 wanita masing-masing diukur tinggi dan berat 

badannya. Berikut adalah gasil pengukurannya : 

  



 

 tinggi berat gender 

1 174.5 65.8 pria 

2 178.6 62.7 pria 

3 170.8 66.4 pria 

4 168.2 68.9 pria 

5 159.7 67.8 pria 

6 167,8 67.8 pria 

7 165.5 65.8 pria 

8 154.7 48.7 wanita 

9 152.7 45.7 wanita 

10 155.8 46.2 wanita 

11 154.8 43.8 wanita 

12 157.8 58.1 wanita 

13 156.7 54.7 wanita 

14 154.7 49.7 wanita 

Penyelesaian : 

Pada kasus ini terdapat 2 sampel yang bebas satu dengan yang lain, yaitu sample bergender 

pria tentu berbeda dengan sample bergender wanita. Di sini populasi diketahui berdistribusi 

normal dank arena sample sedikit, maka digunakan uji t untuk 2 sampel. 

Untuk mepelajari uji statistic ini, inputlah data di atas ke dalam lembar kerja SPSS, dengan 

cara seperti yang telah biasa dilakukan pada SPSS. 

  

Ikuti langkah-langkah berikut ini  

• Setelah data selesai diinput, pilih menu Analyze → Compare Means → Independent 

Sample t Test 

 
Gambar 3.4 : Kotak dialog Independent t Test 

Pengisian ; 

• Sorot variable tinggi, klik panah dalam kotak kecil bagian atas sehingga variable tinggi 

masuk ke dalam kotak Test Variable. 

• Ulangi langkah ini untuk variable berat 

• Sorot variable gender, klik pada panah dalam kotak kecil bagian bawah, sehingga pada 

kotak Grouping Variable terisi gender. Dengan demikian kotak Define Groups menjadi 

aktif. 

• Klik Define Groups, sehingga muncul kotak dialog Define Groups  

• Untuk group 1, isi dengan angka 1 yang berarti grup 1 berisi tanda 1 atau “pria” 

• Untuk group 2, isi dengan angka 2 yang berarti grup 2 berisi tanda 2 atau “wanita” 

• Tekan Continue untuk kembali ke menu sebelumnya. 

• Tekan OK untuk mengakhiri pengisian prosedur analisis dan memulai proses data. 

Output dan Analisis 



 Group Statistics 

 

  

gender 

sampel N Mean 

Std. 

Deviation 

Std. 

Error 

Mean 

tinggi pria 7 169.300 6.1351 2.3189 

wanita 7 155.314 1.6426 .6208 

berat pria 7 66.457 2.0231 .7647 

wanita 7 49.557 5.1555 1.9486 

 

Output di atas menunjukkan ringkasan statistic dari kedua sample. Dari data tersebut ada 

tidaknya perbedaan secara signifikan (jelas dan nyata) antara BB dan tinggi antara pria dan 

wanita belum dapat diketahui. Untuk itu analisis dilanjutkan pada bagian kedua output. 

 

 Independent Samples Test 

 

    

Levene's 

Test for 

Equality 

of 

Variances t-test for Equality of Means 

    F 

Si

g. t df 

Sig. 

(2-

taile

d) 

Mean 

Differ

ence 

Std. 

Error 

Differ

ence 

95% 

Confidence 

Interval of the 

Difference 

                  Lower 

Uppe

r 

tinggi Equal 

variance

s 

assume

d 

5.47

5 

.03

7 
5.826 12 .000 

13.985

7 

2.400

5 
8.7554 

19.2

160 

  Equal 

variance

s not 

assume

d 

    5.826 6.856 .001 
13.985

7 

2.400

5 
8.2850 

19.6

864 

berat Equal 

variance

s 

assume

d 

4.34

5 

.05

9 
8.074 12 .000 

16.900

0 

2.093

3 

12.339

2 

21.4

608 

  Equal 

variance

s not 

assume

d 

    8.074 7.805 .000 
16.900

0 

2.093

3 

12.051

8 

21.7

482 

 



 

Uji t 2 sampel dilakukan dalam 2 tahap, yaitu pertama menguji apakah varians dari dua populasi 

dapat dianggap sama? Tahap selanjutnya dilakukan pengujian untuk melihat ada tidaknya 

perbedaan rata-rata populasi. Pada dasarnya uji t mensyaratkan adanya kesamaan varians 

daridua populasi yang diuji. Jika asumsi tersbut tidak terpenuhi, maka SPSS akan menyediakan 

alternative jawaban uji t  yang lain. 

Tinggi badan 

Pertama-tama dilakukan uji F untuk menguji asumsi kesamaan varians  

Hipotesis : 

H0 = kedua varians populasi adalah identik (varians populasi tinggi badan pria   dan wanita 

adalah sama 

H1 =  kedua varians populasi adalah tidak identik (varians populasi tinggi badan pria dan wanita 

adalah berbeda 

Pengambilan Keputusan  

• Jika probabilitas > 0,05, maka H0 diterima 

• Jika probabilitas < 0,05, maka H0 ditolak 

 

Keputusan : 

• Terlihat bahwa F hitung untuk tinggi badan dengan equal variance assumed (diasumsi 

kedua varians sama atau menggunakan pooled variance t test) adalah 5,475 dengan 

probabilitas 0,037. karena probabilitas < 0,05 maka H0 ditolak, artinya kedua varians benar-

benar berbeda. 

• Oleh karena perbedaan yang nyata dari kedua varians, maka penggunaan varians untuk 

membandingkan rata-rata populasi dengan t test sebaiknya menggunakan dasar Equal 

variance not assumed (diasumsi kedua verians tidak sama) 

• Setelah uji asumsi kesamaan varians selesai, kemudian dilakukan analisis dengan 

menggunakan t test untuk mengetahui apakah rata-rata tinggi badan pria dan wanita adalah 

berbeda secara signifikan? 

 

Hipotesis : 

Hipotesis untuk kasus ini 

H0 = kedua rata-rata populasi adalah identik (rata-rata populasi tinggi badan pria dan wanita 

adalah sama) 

H0 = kedua rata-rata populasi adalah tidak identik (rata-rata populasi tinggi badan pria dan 

wanita adalah  berbeda) 

Catatan : tidak seperti asumsi sebelumnya yang menggunakan varians, sekarang dipakai mean 

atau rata-rata hitung 

Karena tidak ada kalimat lebih tinggi atau kurang tinggi, maka dilakukan uji dua sisi. 

 

Pengambilan keputusan  

• Jika probabilitas > 0,05, maka H0 diterima 

• Jika probabilitas < 0,05, maka H0 ditolak 

 

Keputusan : 

Dari table output dapat diketahui bahwa t hitung untuk Tinggi badan dengan Equal Variance 

not assumed (diasumsi kedua varians tidak sama atau menggunakan separate variance test) 

adalah 5,826 dengan probabilitas 0,001. Oleh karena probabilitas < 0,05, maka H0 ditolak, 

berarti kedua rata-rata tinggi badan pria dan wanita benar-benar berbeda, Jika dilihat dari rata-

ratanya pria mempunyai rata-rata tinggi lebih besar dari wanita. 



Perhatikan bahwa perbedaan dari penggunaan Equal variance assumed ke Equal variance not 

assumed mengakibatkan menurunnya degree of freedom (derajat kebebasan) dari 12 menjadi 

6,856 atau kegagalan mengasumsikan kesamaan varians berakibat keefektivan ukuran sample 

menjadi berkurang sekitar 40% lebih.  

 

 Tugas : 

Berdasar table output yang sama, coba jelaskan (analisis) arti statistic dari nilai-nilai yang ada 

pada table tersebut, untuk variable berat badan. Perhatikan nilai F hitung, probabilitas. Ada 

tidaknya beda nyata antara kedua varians, pembandingan rata-rata populasi menggunakan 

Equal variance assumed ataukah not assumed. 

 

Ringkasan dari test di atas : 

• Diuji dengan F test dahulu (Levene test) apakah hipotesis varians sama , ditolak ataukah 

tidak 

• Jika hipotesis ditolak, atau varians berbeda, maka untuk membandingkan Means digunakan 

t test dengan asumsi varians tidak sama 

• Jika hipotesis diterima, atau varians sama, maka terlihat otomatis pada output SPSS tidak 

ada angka untuk t test Equal variance not assumed. Oleh karena itu test dengan uji t  untuk 

membandingkan means langsung dilakukan dengan equal variance assumed. 

 

One way ANOVA 

 Untuk pengujian lebih dari 2 sampel uji statistic yang dapat digunakan adalah uji 

ANOVA . asumsi yang digunakan pada pengujian menggunakan ANOVA adalah : 

a. populasi-populasi yang akan diuji berdistribusi normal 

b. varians dari populasi-populasi tersebut adalah sama 

c. sample tidak berhubungan satu dengan yang lain 

Contoh : 

Andro melakukan penelitian KTI mengenai pengaruh berbagai dosis ekstrak pare terhadap 

kecepatan gerakan sperma. Untuk itu ia menggunakan hewan coba mencit jantan sebanyak 12 

ekor. Dari ke 12 mencit dibagi menjadi 4 kelompok (masing-masing terdiri 3 ekor mencit) 

dengan perlakuan pemberian ekstrak pare yang berbeda. Kelompok A diberi perlakuan dosis 

ekstrak 100mg/hari, kelompok B 200 mg/hari, C 300 mg/hari, D 400 mg/hari. Pemberian 

ekstrak pare diberikan selama 30 hari berurut-turut. Dari percobaan tersebut diperoleh hasil sbb 

: 

 

Mencit A B C D 

1 22,4 20,6 15,3 13,3 

2 21,5 19,3 16,1 12,7 

3 22,1 18,9 15,8 13,5 

 

Penyelesaian : 

Kasus di atas terdiri atas sample yang bebas satu sama lain, yaitu dosis A, B, C. D yang berbeda 

dosisnya.Di sini populasi keempat kelompok dosis diketahui berdistribusi normal, karena 

jumlah sample lebih dari 2 kelompok, maka digunakan uji ANOVA 

 

Input data : 

Supaya data dapat diolah dengan SPSS, maka format data harus disesuaikan dengan formatnya 

SPSS. Cobalah menginput data tersebut sehingga diperoleh hasil seperti di bawah ini : 



 
Gambar 3.5 : Data View ANOVA 

Pengolahan data : 

Langkah-langkah: 

❖ (masih di area data view seperti di atas) pilih menu Analyze →Compare Means →One-

Way ANOVA, sehingga tampak kotak dialog berikut ini 

 
Gambar 3.6 : Kotak Dialog ANOVA 

Pengisian : 

❖ Dependent List (variable yang akan diuji), masukkan variable kecepatan 

❖ Factor atau grup, masukkan dosis(perlakuan) 

❖ Klik Options  

❖ Untuk keseragaman, pilih Deskriptive & homogeneity of variance, hingga kotak kecil 

terisi tanda √ 

❖ Untuk Missing Value, karena data kita komplit tidak ada yang hilang, maka pilihan ini 

dapat diabaikan  

❖ Tekan Continue untuk melanjutkan proses pengolahan data, kembali ke kotak dialog 

ANOVA, lanjutkan dengan memilih Post Hoc atau analisis lanjutan. Untuk keseragaman, 

pilih Tukey 

❖ Tekan Continue jika pengisian dianggap selesai 

❖ Kemudian tekan OK untuk mengakhiri pengisian prosedur analisis. 

 

Output SPSS dan Analisis : 



Oneway 

 Descriptives 

 

   

 

Perla 

kuan N Mean 

Std. 

Deviati

on 

Std. 

Error 

95% Confidence 

Interval for Mean 

Minimu

m 

Maximu

m 

Lower 

Bound 

Upper 

Bound 

100 
3 22.0000 .45826 .26458 

20.861

6 
23.1384 21.50 22.40 

200 
3 19.6000 .88882 .51316 

17.392

1 
21.8079 18.90 20.60 

300 
3 15.7333 .40415 .23333 

14.729

4 
16.7373 15.30 16.10 

400 
3 13.1667 .41633 .24037 

12.132

4 
14.2009 12.70 13.50 

Total 
12 17.6250 3.59498 

1.0377

8 

15.340

9 
19.9091 12.70 22.40 

 

Output ini menggambarkan ringkasan statistic dari keempat sample. Sebagai contoh, pada 

perlakuan 100 mg. rata-rata kecepatan gerak sperma adalah 22,00 mm/mnt. Kecepatan 

minimum 21,5 mm/mnt dan maksimum 22,4 mm/mnt. Dengan tingkat kepercayaan 95% atau 

significansi 5%, rata-rata kecepatan ada pada range 20,8816 sampai 23,1384. 

Untuk latihan, coba baca dan jelaskan ringkasan table statistic untuk 3 sample yang lain. 

 

Test of Homogeneity of Variances 

 

   

Levene 

Statistic df1 df2 Sig. 

1.645 3 8 .255 

 

Analisis ini bertujuan untuk menguji berlaku tidaknya asumsi untuk ANOVA, yaitu apakah 

keempat sample mempunyai varians yang sama 

Hipotesis : 

H0 = keempat varians populasi adalah identik 

H1 = keempat varians populasi adalah tidak identik 

Pengambilan keputusan 

• Jika probabilitas > 0,05, maka H0 diterima 

• Jika probabilitas < 0,05, maka H0 ditolak 

 

 Keputusan : 

Terlihat bahwa Levene T hitung adalah 1,645 dengan nilai probabilitas 0,255. Oleh karena 

probabilitas > 0,05, maka H0 diterima atau berarti keempat varians adalah sama. Dengan 

demikian, asumsi kesamaan varians untuk uji ANOVA sudah terpenuhi. 

 

 ANOVA 

 

   



  

Sum of 

Squares df 

Mean 

Square F Sig. 

Between 

Groups 
139.489 3 46.496 139.141 .000 

Within Groups 2.673 8 .334     

Total 142.163 11       

Uji ini digunakan untuk menguji apakah dari keempat sample mempunyai rata-rata yang sama. 

Analisis menggunakan ANOVA : 

Hipotesis : 

H0 = keempat rata-rata populasi adalah identik 

H1 = keempat rata-rata populasi adalah tidak identik 

Catatan: pada uji ini yang digunakan untuk asumsi adalah mean, bukan lagi varians. 

 

Pengambilan Keputusan 

Dapat didasarkan pada : 

1. perbandingan F hitung dan F table 

dasar pengambilan keputusan sama dengan uji F 

2. nilai probabilitas → lebih praktis 

jika probabilitas > 0,05, maka H0 diterima 

jika probabilitas < 0,05, maka H0 ditolak 

keputusan : melihat bahwa F hitung adalah 139,141 dengan probabilitas 0,000 < 0,05, 

maka H0 ditolak → berarti rata-rata kecepatan gerak sperma dari keempat perlakuan 

dosis tersebut memang berbeda. Untuk mengetahui di antara keempat kelompok, mana 

saja kelompok yang berbeda dan mana saja yang tidak berbeda, hal ini akan dibahas 

pada analisis Tukey dalam post hoc test berikut. 

 

 

Post Hoc Tets 

 Multiple Comparisons 

 

Dependent Variable:    

Tukey HSD  

(I) dosis (J) dosis 

Mean 

Difference 

(I-J) 

Std. 

Error Sig. 

95% Confidence Interval 

Lower 

Bound 

Upper 

Bound 

100 200 2.40000(*

) 
.47199 .004 .8885 3.9115 

300 6.26667(*

) 
.47199 .000 4.7552 7.7782 

400 8.83333(*

) 
.47199 .000 7.3218 10.3448 

200 100 -

2.40000(*

) 

.47199 .004 -3.9115 -.8885 

  300 3.86667(*

) 
.47199 .000 2.3552 5.3782 

400 6.43333(*

) 
.47199 .000 4.9218 7.9448 



300 100 -

6.26667(*

) 

.47199 .000 -7.7782 -4.7552 

  200 -

3.86667(*

) 

.47199 .000 -5.3782 -2.3552 

400 2.56667(*

) 
.47199 .003 1.0552 4.0782 

400 100 -

8.83333(*

) 

.47199 .000 -10.3448 -7.3218 

  200 -

6.43333(*

) 

.47199 .000 -7.9448 -4.9218 

300 -

2.56667(*

) 

.47199 .003 -4.0782 -1.0552 

*  The mean difference is significant at the .05 level. 

Uji signifikansi perbedaan, berdasarkan nilai probabilitas 

• jika probabilitas > 0,05, maka H0 diterima 

• jika probabilitas < 0,05, maka H0 ditolak 

Post hoc di atas menunjukkan probabilitas kesemuanya < 0,05, maka H0 ditolak, berarti 

perbedaan mean diantara keempat kelompok tersebut benar-benar nyata (hubungan antar 

variable). Hal tersebut juga dapat dilihat dengan adanya tanda (*) dibelakang angka Mean 

Difference. 

 

Homogeneous Subsets   

 

Tukey HSD  

dosis N 

Subset for alpha = .05 

1 2 3 4 

400 3 13.1667       

300 3   15.7333     

200 3     19.6000   

100 3       22.0000 

Sig.   1.000 1.000 1.000 1.000 

Means for groups in homogeneous subsets are displayed. 

a  Uses Harmonic Mean Sample Size = 3.000. 

Homogeneous Subsets bertujuan untuk mencari grup/subset mana saja yang mempunyai 

perbedaan rata-rata yang tidak berbeda secara signifikan.Cara membaca yang paling mudah 

dari output ini adalah, jika nilai rata-rata terletak dalam satu kolom subsets yang sama, maka 

menunjukkan tidak ada perbedaan yang nyata. Output di atas menunjukkan bahwa keempat 

kelompok saling berbeda nyata satu dengan yang lain → ada 4 subsets yang masing-masing 

terisi satu nilai rata-rata. 

 

 Uji-uji komparatif di atas adalah beberapa contoh uji statistic  untuk data-data yang memenuhi 

syarat untuk diuji parametric. Data-data yang tidak memenuhi syarat untuk diuji parametric, 

maka harus digunakan uji statistic alternative, yaitu yang nonparametric. Beberapa uji statistic 

non parametric akan dijelaskan pada saat praktikum, berikut dengan contoh-contohnya. 

 



Panduan praktis interpretasi uji hipotesis 

 

No. Nama Uji Makna jika p<0,05 (Hipotesis nol ditolak) 

1. Uji normalitas Kolmogorov 

Smirnov, Shapiro-Wilk 

Distribusi data tidak normal 

2. Uji Varians Levene’s Distribusi data yang dibandingkan 

mempunyai varian yang berbeda 

3. Uji One Way Anova Paling tidak, terdapat dua kelompok data yang 

mempunyai perbedaan yang bermakna (untuk 

mengetahui kelompok mana yang berbeda 

secara bermakna, harus dilakukan analisis 

Post Hoc 

4. Uji Repeated ANOVA 

5. Uji Kruskal Wallis 

6. Uji Friedman 

7. Uji Mc Nemar Terdapat perbedaan yang bermakna antara 

dua pengukuran 

8. Uji Marginal Homogenity Terdapat perbedaan yang bermakna antara 

dua pengukuran 

9. Uji Cochran Paling tidak, terdapat perbedaan pada dua 

pengukuran 

 

Latihan/tugas : 

 Pada saat praktikum, mahasiswa diberi set data dari suatu kasus (contoh penelitian). 

Mahasiswa diberi tugas untuk melakukan praktek input data, menentukan uji statistik yang 

tepat sesuai prosesur yang telah diajarkan, menginterpretasikan hasil uji statistik tersebut untuk 

menarik kesimpulan yang tepat. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  



K. MATERI IV 

L. REGRESI dan KORELASI 

 

Telah diketahui bahwa uji statistic pada dasarnya meliputi dua kegiatan, yakni uji beda 

dan uji asosiasi. Uji beda (difference) digunakan untuk mengetahui apakah ada perbedaan yang 

jelas antara rerata beberapa sample. Sedangkan uji asosiasi digunakan untuk mengetahui 

apakah di antara dua variable terdapat hubungan yang signifikan. Uji asosiasi meliputi korelasi 

dan regresi. 

 

KORELASI 

 Pada bab ini akan ditinjau 2 aspek untuk analisis korelasi, yaitu apakah data sample 

yang ada menyediakan bukti cukup bahwa ada kaitan antara variable-variabel dalam populasi 

asal sample. Dan yang kedua adalah jika ada hubungan, seberapa kuat hubungan antar variable 

tersebut. Keeratan hubungan itu dinyatakan dengan nama koefisien korelasi ( kadang disebut 

korelasi saja). Untuk uji korelasi yang dapat digunakan, sesuai denganjenis variabelnya, dapat 

dilihat di dalam table berikut ini : 

Tabel  3 : Pemilihan Hipotesis Korelatif 

Variabel 1 Variabel 2 Uji Korelasi 

Nominal Nominal Koefisien Kontengensi, Lambda 

Nominal Ordinal  Koefisien Kontengensi, Lambda 

Ordinal  Ordinal  Spearman, Gamma, Somers’d 

Ordinal Numeric  Spearman 

Numeric  Numeric  Pearson 

Catatan : jika syarat untuk uji Pearson tidak memenuhi, maka digunakan uji alternative, yaitu 

uji korelasi Spearman (uji nonparametric) 

 

Bagaimana Interpretasi hasil uji korelasi? 

Interpretasi hasil uji korelasi didasarkan pada nilai p, kekuatan korelasi serta arah korelasinya.  

 

Tabel 4 : Interpretasi Hasil Uji Korelasi 

No. Parameter Nilai Interpretasi 

1. Kekuatan 

Korelasi (r) 

0,00-0,199 

0,20-0,399 

0,40-0,599 

0,60-0,799 

0,80-1,00 

Sangat Lemah 

Lemah 

Sedang 

Kuat 

Sangat Kuat 

2. Nilai p  

(dalam SPSS, 

ditunjukkan 

dengan nilai Sig.) 

p< 0,05 

 

 

p>0,05 

Terdapat korelasi yang bermakna 

antara dua variabel yang diuji 

Tidak terdapat korelasi yang 

bermakna antara dua variabel 

yang diuji 

3. Arah korelasi + (positif) 

 

 

- (negatif) 

Searah, semakin besar nilai satu 

variabel semakin besar pula nilai 

variabel lainnya 

Berlawanan arah, semakin besar 

nilai satu variabel, semakin kecil 

nilai variabel lainnya 

 

Contoh : 



 Untuk korelasi sederhana dengan data x1 dan x2 menggunaan angka adalah sebagai 

berikut : 

 Ingin diketahui apakah ada korelasi antara berat badan ibu dengan berat badan bayi 

yang dilahirkan di Sleman, ada 9 sampel yang digunakan. Berikut datanya : 

No. BB ibu (X1) BB bayi lahir (X2) 

1 80 3 

2 86 3,10 

3 87 3,14 

4 90 3,30 

5 78 2,60 

6 70 2,50 

7 65 2,51 

8 60 1,80 

9 62 1,90 

 

Coba input data tersebut dengan mengisi variable view, kemudian lanjutkan dengan 

memasukkan data pada data view. Diumpamakan  distribusi data adalah normal, maka uji dapat 

dilanjutkan dengan uji korelasi Pearson. 

 

 
Gambar 4.1 : Variable View untuk contoh kasus Korelasi 

Coba lakukan analisis statistic dengan langkah seperti berikut ini 

• Klik menu Analyze → Correlate → Bivariate 

• Masukkan variable BB ibu dan BB bayi lahir ke dalam kotak Variables 

• Pilih (klik) Pearson dan Two-taled 

• Tekan OK 

 
Gambar 4.2 : kotak dialog Bivariate Correlations 

 

Output dan Analisis 

 

 Correlations 

 

    BB ibu 

BB bayi 

lahir 



BB ibu Pearson 

Correlation 
1 .953(**) 

Sig. (2-tailed) . .000 

N 9 9 

BB bayi lahir Pearson 

Correlation 
.953(**) 1 

Sig. (2-tailed) .000 . 

N 9 9 

**  Correlation is significant at the 0.01 level (2-tailed). 

 

Masalah : Apakah terdapat hubungan antara berat badan ibu dengan berat badan bayi lahir di 

Sleman? 

Hipotesis : 

H0 : tidak terdapat hubungan antara BB Ibu dengan BB bayi lahir di Sleman 

H1 : terdapat hubungan antara BB Ibu dengan BB bayi lahir di Sleman 

 

Keputusan : 

Jika Sig > 0,05 maka H0 diterima 

Jika Sig < 0,05 maka H0 ditolak 

 

Pengambilan Keputusan : 

 Nilai sig = 0,000, maka H0 ditolak berarti terdapat hubungan antara BB ibu dengan 

BB bayi lahir. Koefiseien korelasi = 0,953, berarti hubungannya sangat kuat sekali. 

 

REGRESI  

 Regresi bertujuan untuk menguji pengaruh antara satu variable dengan variable lain. 

Variabel yang dipengaruhi disebut variable tergantung atau dependen, sedangkan variable yang 

mempengaruhi disebut variable bebas atau variable independent. Uji regresi ada 2, yaitu : 

1. Regresi linier sederhana (= Simple Regression) 

      yaitu jika hanya ada satu variable dependent dan satu variable independent  

2. Regresi linier berganda (Multiple Regression)  

      yaitu jika ada satu variable dependen dan lebih dari satu variable independent  

 

REGRESI LINIER SEDERHANA 

Model persamaan regresi linier sederhana adalah sebagai berikut : 

Y = a + b1X1 +e 

Contoh soal : 

 Ingin diketahui apakah ada pengaruh antara BB ibu dengan BB bayi yang dilahirkan di 

Sleman, dengan sample 9. Dengan menggunakan data untuk korelasi pada bab sebelum ini, 

dilakukan analisis regresi dengan langkah-langkah berikut : 

1. Pengolahan Data 

• Buka lembar kerja (file Korelasi) 

• Klik Analyze → Regression → Linear 

• Masukkan BB ibu ke kotak Dependent dan BB bayi pada kotak Independent sehingga 

tampak kotak dialog seperti di bawah ini : 

 



 
Gambar 4.3 : kotak dialog Linear Regression 

• Langkah selanjutnya, untuk keseragaman, biarkan sesuai default yang ada. 

 

2. Output dan analisis 

 

Regression 

 

Variables Entered/Removed(b) 

 

Mode

l 

Variables 

Entered 

Variables 

Removed Method 

1 BB bayi 

lahir(a) 
. Enter 

a  All requested variables entered. 

b  Dependent Variable: BB ibu 

 

 

 

 

 

Model Summary(b) 

 

Mode

l R R Square 

Adjusted 

R Square 

Std. Error 

of the 

Estimate 

1 .953(a) .908 .895 3.695 

a  Predictors: (Constant), BB bayi lahir 

b  Dependent Variable: BB ibu 

 

 

 



ANOVA(b) 

 

Model  

Sum of 

Squares df 

Mean 

Square F Sig. 

1 Regressi

on 
946.422 1 946.422 69.315 .000(a) 

Residual 95.578 7 13.654   

Total 1042.000 8    

a  Predictors: (Constant), BB bayi lahir 

b  Dependent Variable: BB ibu 

 

Coefficients(a) 

 

Model  

Unstandardized 

Coefficients 

Standardized 

Coefficients 

t Sig. B 

Std. 

Error Beta 

1 (Consta

nt) 
21.778 6.550  3.325 .013 

BB bayi 

lahir 
20.210 2.427 .953 8.326 .000 

a  Dependent Variable: BB ibu 

 

Perumusan masalah : 

 Apakah terdapat pengaruh antara BB ibu dengan BB bayi lahir ? 

 

Hipotesis : 

H0 : tidak ada pengaruh antara BB ibu dengan BB bayi lahir 

Ha : ada pengaruh antara BB ibu dengan BB bayi lahir 

Pengambilan Keputusan 

 Y = BB ibu 

 X = BB bayi lahir 

 

Cara 1 : 

Jika Sig > 0,05 maka H0 diterima 

Jika Sig < 0,05 maka H0 ditolak 

 

Cara 2 

Jika t table < t hitung , t table maka H0 diterima 

Jika t hitung , -t dan t hitung > t table maka H0 ditolak 

Cara 1 dari penelitian di atas, diperoleh Sig = 0,000 < 0,05 maka H0 ditolak 

Cara 2 untuk t table kita melihat di table (df= n-1; dua sisi) = 2,3060  

t hitung = 8,326 → berada pada daerah H0 ditolak. 

 Setelah diketahui bahwa ada pengaruh antara BB ibu dengan BB bayi , besar pengaruhnya 

adalah 20,210 jadi persamaan regresinya adalah : 

 Y = 21,778 + 20,210X + e 

Jika BB bayi lahir naik 1  satuan, maka BB ibu akan meningkat 20,210. Nilai R square adalah 

0,908 (adalah pengkuadratan dari koefisien korelasi (0,953)2 . R square dapat disebut koefisien 

determinasi yang dalam hal ini berarti 90,8% BB ibu dipengaruhi oleh BB bayi lahir. 



    

 

UJI CHI-SQUARE 

 

Uji Chi Square untuk satu sampel 

Uji ini dapat dipakai untuk menguji apakah data sebuah sample yang diambil 

menunjang hipotesis yang menyatakan bahwa populasi asal sample tersebut mengikuti suatu 

distribusi yang telah ditetapkan. Uji ini juga dapat disebut uji keselarasan (goodness of fit test) 

karena untuk menguji apakah sebuah sample selaras dengan salah satu distribusi teoritis 

(seperti distribusi normal, uniform, binomial dan lainnya) Namun pada penerapannya, uji ini 

tetap mengikuti prinsip dasar pengujian Chi-Square, yaitu membandingkan antara frekuensi-

frekuensi harapan dengan frekuensi-frekuensi teramati. 

Contoh kasus : 

   Manager PT Vita Indo yang menjual produk vitamin C dosis tinggi dengan empat 

macam rasa ingin mengetahui apakah konsumen menyukai keempat macam rasa vitamin 

tersebut. Untuk keperluan ini, dia dalam waktu satu minggu diamati pembelian permen di suatu 

outlet dab diperoleh hasil sebagai berikut : 

 

 

Rasa Jumlah 

Orange 35 

Lemon 28 

Grape 10 

Mango 27 

 

Penyelesaian : 

Oleh karena akan menguji apakah sebuah sample mengikuti distribusi tertentu, maka 

digunakan uji Chi-Square 

Langkah-langkah : 

1. buka lembar kerja baru 

2. definisikan Variabel dan property yang diperlukan, dengan cara seperti biasanya dalam 

pendefinsian data dalam SPSS, sehingga tampak di layar seperti di bawah ini. Lakukan 

kodifikasi untuk variable RASA 

  

  
Gambar 4.4 : Variable View untuk contoh kasus Chi-Square Test 

3. Mengisi data : sebelum mengisi, klik menu VIEW → VALUE LABEL 

Lanjutkan dengan mengisi data sesuai kolomnya 

4. Melakukan Process Weight Cases 

Variabel RASA yang telah dikodifikasi, kemudian dilakukan proses Weight Cases 

untuk menghubungkan dengan variable jumlah. Adapun caranya adalah sbb : 

• Letakkan pointer pada kolom variable RASA 

• Dari menu utama SPSS, pilih menu Data → Weight Cases  

• Karena variable yang akan dihubungkan adalah JUMLAH, maka pindahkan 

variable JUMLAH ke pilihan Frequency Variable, sehingga tampak kotak 

dialog seperti di bawah ini 



 
Gambar 4.5 : Kotak dialog Weight Cases 

5. Pengolahan data ; 

• Masih di file Chi-Square, lanjutkan dengan memilih Menu Analyze → 

Nonparametrik Test → Chi-Square…,    

• Variabel yang akan diuji yaitu RASA dipindahkan ke kotak Test Variable List 

• Kolom Expected Range pilih Get from data, karena akan dihitung dari data kasus 

• Kolom Expected Values, pilih All categories equal, karena distribusinya adalah 

uniform (semua kemungkinan adalah sama), seperti pada kotak dialog di bawah ini. 

 

 
Gambar 4.6 : kotak dialog Chi-Square test 

•  Klik OK 

 

 Output dan Analisis 

 

NPar Tests 

Chi-Square Test 

 

Frequencies 

 RASA 

 

  

Observed 

N 

Expected 

N Residual 

Orange 35 25.0 10.0 

Lemon 28 25.0 3.0 

Grape 10 25.0 -15.0 

Mango 27 25.0 2.0 

Total 100     

 

Expected N, artinya jumlah Rasa vitamin yang diharapkan terbeli. Oleh karena dipakai 

distribusi yang seragam, maka diharapkan sama rata, yaitu 25% (100% dibagi 4 rasa), kolom 

Residual adalah selisih antara jumlah yang dibeli dengan jumlah yang diharapkan. 

 



Hipotesis  

H0 : sample diambil dari populasi yang mengikuti distribusi seragam, atau rasa vitamin yang 

ada disukai konsumen secara merata. 

H1 : sample bukan berasal dari populasi yang mengikuti distribusi seragam, atau setidaknya 

sebuah rasa vitamin lebih disukai daripada setidaknya sebuah rasa lain. 

 

 Test Statistics 

 

  RASA 

Chi-

Square(a) 
13.520 

df 3 

Asymp. 

Sig. 
.004 

a  0 cells (.0%) have expected frequencies less than 5. The minimum expected cell frequency 

is 25.0. 

 

Pengambilan Keputusan : 

a. Berdasarkan perbandingan Chi-Square Uji dan Tabel 

Jika Chi-Square hitung < Chi-Square table, maka H0 diterima 

Jika Chi-Square hitung > Chi-Square table, maka H0 ditolak 

• Chi-Square hitung → lihat pada output, adalah = 13,520 

• Chi-Square table → lihat table Chi-Square dengan α = 5%, dan df = 3 (lihat output atau 

dari rumus k – 1) → Chi-Square table untuk kasus ini adalah 7,814 

• Jadi Chi-Square hitung > Chi Square table (13,520 > 7,814) → maka H0 ditolak 

b. Berdasarkan Probabilitas 

• Jika probabilitas > 0,05, maka H0 diterima 

• Jika probabilitas < 0,05, maka H0 ditolak 

      Keputusan : 

• Dapat dibaca pada kolom Asymp.Sig/Asiymptotic significance adalah 0,04, atau 

probabilitas di bawah 0,05→ H0 ditolak 

Berdasar 2 analisis diatas, dapat diambil kesimpulan yang sama, yaitu H0 ditolak, artinya 

populasi tidak seragam (konsumen tidak mempunyai kesukaan yang sama terhadap keempat 

macam rasa vitamin tersebut. 

 

Uji Chi-Square (Hipotesis Komparatif Karegorik tidak berpasangan) 

 

Contoh kasus (sekaligus untuk latihan/tugas)  

Jika ingin mengetahui hubungan antara perilaku merokok merokok dan tidak merokok) dengan 

status fertilitas pria (infertil dan fertil). Dirumuskan pertanyaan sebagai berikut : ” Apakah 

terdapat hubungan antara perilaku merokok dengan status fertilitas seorang pria? 

Uji apakah yang mungkin digunakan untuk menjawab pertanyaan tersebut? 

Langkah-langkah yang digunakan untuk menjawab pertanyaan tersebut adalah sebagai berikut 

: 

1. Tentukan variabel yang akan dihubungkan  

2. Tentukan jenis hipotesis 

3. Tentukan masalah skala variabel 

4. Tentukan berpasangan atau tidak 

5. Tentukan jenis tabel B x K (Baris x Kolom) 



6. Menarik kesimpulan uji statistik yang tepat 

Coba praktekkan langkah-langkah tersebut, buatlah jawabannya (alasan), mengapa digunakan 

uji Chi Square? Uji alternatif apakah yang digunakan jika syarat-syarat untuk uji ini tidak 

terpenuhi?   

 

Langkah-langkah pengujian: 

1. Lakukan input data (data diberikan pada saat praktikum) seperti yang sudah kalian 

lakukan pada materi sebelumnya. 

 Lakukan langkah berikut (klik): 

2. Analyze → Descriptive statistics → Croostabs 

3. masukkan variabel rokok ke dalam Rows (sebagai variabel bebas) 

4. masukkan variabel subur ke dalam Columns (sebagai variabel terikat) 

 
5. Klik kotak Statistics, lalu pilih Chi-Square pada kiri atas kotak, lalu klik Continue 

 
6. Klik Cell, pilih Observed untuk menampilkan nilai observed dan pilih Expected untuk 

menampilkan nilai expected pada kotak Count, lalu klik Continue 



 
7. Proses telah selesai, Klik Continue, Klik OK 

 

Coba lihat outputnya! 

 

perilaku merokok * Status fertilitas Crosstabulation 

 

    

Status fertilitas 

Total subur 

tidak 

subur 

perilaku 

merokok 

tidak merokok Count 35 15 50 

Expected 

Count 
27.5 22.5 50.0 

merokok Count 20 30 50 

Expected 

Count 
27.5 22.5 50.0 

Total Count 55 45 100 

Expected 

Count 
55.0 45.0 100.0 

 

 

Chi-Square Tests 

 

  Value df 

Asymp. 

Sig. (2-

sided) 

Exact 

Sig. (2-

sided) 

Exact 

Sig. (1-

sided) 

Pearson Chi-

Square 
9.091(b) 1 .003     

Continuity 

Correction(a) 
7.919 1 .005     

Likelihood Ratio 9.240 1 .002     

Fisher's Exact 

Test 
      .005 .002 

Linear-by-Linear 

Association 
9.000 1 .003     

N of Valid Cases 100         

a  Computed only for a 2x2 table 

b  0 cells (.0%) have expected count less than 5. The minimum expected count is 22.50. 



 

 

 

Interpretasi Hasil  

1. Tabel atas mendeskripsikan masing-masing sel untuk nilai observed dan expected. 

Nilai observed untuk sel a, b,c & d masing-masing 35, 15, 20 dan 30; sedangkan 

expectednya masing-masing 27.5, 22.5, 27.5 dan 22.5. 

2. Tabel 2x2 ini layak diuji dengan Chi Square karena tidak ada nilai expected yang 

kurang dari 5 

3. Tabel di bawahnya menunjukkan hasil uji Chi Square. Nilai yang dipakai adalah pada 

nilai Pearson Chi-Square, dengan nilai Significancy nya adalah 0.003, berarti terdapat 

hubungan antara perilaku merokok dengan status fertilitas. 

 

Interpretasi lengkap nilai p 

 Jika tidak ada hubungan antara perilaku merokok dengan status kesuburan, maka faktor 

peluang saja menerangkan 0.003 hasil yang diperoleh. Karena faktor peluang kurang dari 5%, 

maka hasil tersebut bermakna. 
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